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Não pode faltar

Apresentação do ambiente de desenvolvimento Android Studio

O desenvolvimento de aplicativos para dispositivos móveis 

possui práticas e recursos que são similares ao desenvolvimento 

de softwares para um computador convencional (PC). Em ambos 

os casos, o programador poderia abrir um simples editor de texto, 

como o bloco de notas, digitar seu código e fazer a compilação 

usando o compilador específico. Essa prática, embora muito 

utilizada nos primórdios da programação, não é mais utilizada 

no mercado de trabalho. Essa metodologia foi substituída 

por ambientes de desenvolvimento, mais especificamente, 

por ambientes de desenvolvimento integrado (IDE, do inglês, 

Integrated Development Environments). Segundo Silva (2016, p. 

35), “Os IDEs são ferramentas que os desenvolvedores utilizam 

para diversos processos relativos ao código, como: criação, 

edição, compilação e depuração”. Portanto, uma IDE possui uma 

série de ferramentas necessárias ao desenvolvimento de softwares 

já integrado ao ambiente, o que facilita e agiliza o desenvolvimento 

para o programador.

Uma forma de desenvolvimento de aplicativos para Android que 

foi amplamente utilizada consistia na combinação da IDE Eclipse 

em conjunto com o ADT (Android Developer Tools). Entretanto, 

caso você tente utilizar tal recurso, irá encontrar a mensagem 

da Figura 4.7 na documentação oficial do desenvolvimento  

para Android.

Figura 4.7 | Captura de tela da documentação oficial

Fonte: <https://developer.android.com/studio/tools/sdk/eclipse-adt.html>. Acesso em: 29 jan. 2018.
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Isso acontece porque, em 2014, a Google anunciou a IDE 
Android Studio como a ferramenta oficial para o desenvolvimento 
de aplicações Android (MULLIS, 2017). Essa IDE trabalha em 
conjunto com o Android SDK (Software Development Kit) o qual 
dará acesso às funcionalidades do sistema operacional em questão. 
Ainda segundo Mullis (2017, p. 1), “Java é necessário para escrever os 
programas, o Android SDK é necessário para fazer esses programas 
serem executados no Android e o Android Studio tem o trabalho de 
colocar tudo junto para você.” 

Instalação do ambiente de desenvolvimento Android Studio.

Para criar e compilar um aplicativo é necessário, em primeiro 
lugar, instalar o JRE (Java Runtime Environment), disponível para 
download no endereço <https://java.com/pt_BR/download/>. 
Acesso em: 05 fev. 2018. O segundo passo é instalar o JDK 
(Java Development Kit), disponível para download no endereço: 
<http://www.oracle.com/technetwork/java/javase/downloads/
jdk8-downloads-2133151.html>. Acesso em: 29 jan. 2018. 
Certifique-se de instalar a versão de acordo o sistema operacional 
do seu computador. Por fim, é preciso instalar o ambiente de 
desenvolvimento Android Studio, disponível para download no 
endereço: <https://developer.android.com/studio/index.html>. 
Acesso em: 29 jan. 2018.

Reflita

A Google investiu dinheiro e tempo para construir e tornar o Android 
Studio a ferramenta oficial para o desenvolvimento de aplicativos para 
Android. Quais vantagens e desvantagens essa medida trouxe para os 
desenvolvedores?

Feito o download de todos os softwares, instale na seguinte 

sequência: (i) JRE; (ii) JDK; e (iii) o Android Studio. Durante a 

instalação do último, marque a opção para também instalar o 

Android SDK. Após preparar o ambiente, você pode criar um novo 

projeto, clicando em File > New > New Project. Ao criar um novo 

projeto, você verá algo semelhante à Figura 4.8 (semelhante porque 

depende de algumas escolhas).

https://java.com/pt_BR/download/
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
http://www.oracle.com/technetwork/java/javase/downloads/jdk8-downloads-2133151.html
https://developer.android.com/studio/index.html
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Ainda sobre a instalação, é possível que, durante a execução da 
IDE Android Studio, o ambiente ainda peça para que você instale ou 
atualize alguns recursos (lembre-se de que essas ferramentas estão 
em constante evolução). Fique atento às mensagens nas barras e 
siga as instruções quando for necessário.

Arquitetura de um aplicativo para Android

Existe um esforço dos desenvolvedores de IDE em tornar sua 
ferramenta prática. Diante dessa corrida, várias funcionalidades são 
incorporadas e vários métodos e bibliotecas são disponibilizados 
nesses ambientes. A consequência é que tais facilidades geram 
várias linhas de código antes mesmo de um programador escrever 
sua primeira linha. O Android Studio é uma das IDE que apresentam 
vários arquivos e várias linhas de código assim que um novo projeto 
é criado, conforme pode ser observado na Figura 4.8. Cada arquivo 
tem uma função específica dentro do projeto, e a junção deles é 
que criará o aplicativo Android. Vamos agora, começar a entender 
a arquitetura de um aplicativo para Android e explorar alguns dos 
principais arquivos.

No mundo da programação para dispositivos Android um termo 
é bastante comum: “Activity”. 

Figura 4.8 | Ambiente do Android Studio

Fonte: elaborada pelo autor.
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Um aplicativo Android terá, no mínimo, uma activity, que é 
chamada de Main Activity (atividade principal). Essa activity representa 
o ponto inicial pelo qual o aplicativo executará e é dividida em dois 
arquivos: MainActivity.Java e activity_main.xml.

Exemplificando

Para entendermos o conceito de activity, vamos ver um exemplo 
usando um aplicativo do celular. Ao abrir o Google Maps, uma activity 
principal é iniciada, conforme outros recursos vão sendo abertos, 
novas activities podem ser iniciadas.

Figura 4.9 | Exemplo de activity no Android

Fonte: <https://www.tecmundo.com.br/internet/119792-aprenda-adicionar-local-google-maps-
smartphone.htm> Acesso em: 29 jan. 2018.

Activity é um componente de aplicativo que fornece uma 
tela com a qual os usuários podem interagir para fazer algo, 
como discar um número no telefone, tirar uma foto, enviar 
um e-mail ou ver um mapa. Cada atividade recebe uma 
janela que exibe a interface do usuário. Geralmente, a janela 
preenche a tela, mas pode ser menor que a tela e flutuar 
sobre outras janelas. (DEVELOPER, 2017, p. 1).
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No arquivo activity_main.xml deverá ser codificado o layout dessa 
activity. Aqui serão inseridos textos, botões, caixas de seleção etc. 
É nesse arquivo que especificamos um layout responsivo, ou seja, 
um layout que se adapta automaticamente ao tamanho da tela do 
usuário. Podemos acessar essa funcionalidade através do gerenciador 
responsivo Constraint Layout e fazendo algumas configurações 
nos objetos.

No arquivo MainActivity.Java deverá ficar a parte de programação 
na linguagem Java, contendo questões relativas ao comportamento 
daquela determinada activity, como por exemplo, decisões e testes 
de validação. Se tratando de uma linguagem orientada a objetos, 
todos os objetos que forem usados no aplicativo serão “criados” 
(instanciados) através de alguma activity, que pode ser a principal, 
como também em outra.

O AndroidManifest.xml é outro arquivo essencial para um 
aplicativo Android, sem esse arquivo não é possível construir a 
aplicação. Ele fica no diretório raiz e possui informações que serão 
consultadas antes do aplicativo ser executado, como por exemplo, 
as bibliotecas usadas, a versão mínima do sistema Android necessária 
para executar a aplicação, dentre outras.

Assimile

Qualquer item adicionado no arquivo activity_main.xml, por 
exemplo, texto, botão, caixa de seleção, etc., deve ser referenciado 
dentro do arquivo MainActivity.Java, pois o correto funcionamento do 
aplicativo depende da ligação de todos os arquivos de construção.

Emuladores do sistema Android (Android Emulator)

Durante a criação do aplicativo, é necessário fazer vários 
testes, para isso são feitas inúmeras compilações (DEITEL; 
DEITEL; WALD, 2016). O resultado de cada compilação pode 
ser visualizado dentro do próprio ambiente de desenvolvimento, 
usando o Android Virtual Device (AVD). Após a instalação do 
Android Studio é provável que o ambiente não tenha nenhuma 
AVD instalada, portanto, você deverá instalar através do AVD 
Manager, que se encontra no menu Tools > Android > AVD 
Manager. A Figura 4.10 é uma captura de tela do ambiente para 
instalação do AVD. 
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Cada AVD define um perfil de hardware e software, ou seja, 
define as características de um celular, tablet, etc. A parte de 
hardware irá simular o funcionamento do hardware do dispositivo, 
já o software simulará a versão do Android, que está associada a 
uma API (Application Programming Interface). Confira na tabela 4.1, 
algumas versões do Android e sua respectiva API.

Figura 4.10 | Instalando um AVD

Fonte: <https://developer.android.com/studio/run/managing-avds.html?hl=pt-br>. Acesso em: 6 
fev. 2018.

É importante ressaltar que para cada projeto é escolhida uma versão 
da API para ser o destino do aplicativo (target), porém a escolha de uma 
API com nível mais alto não significa que o aplicativo não irá funcionar 
nas demais, significa apenas que algumas funcionalidades podem não 
estar disponíveis. Em sua máquina, você pode ter instalado quantas 
versões do sistema operacional Android desejar, para isso basta criar 
diversos emuladores (AVDs), um para cada versão do software.

Tabela 4.1 | Versão Android x API

Fonte: adaptada de: <https://source.android.com/setup/build-numbers>. Acesso em: 19 fev. 2018.

Nome Versão API

Oreo 8.1.0 API nível 27

Oreo 8.0.0 API nível 26

Nougat 7.1 API nível 26

Nougat 7.0 API nível 25

https://developer.android.com/studio/run/managing-avds.html?hl=pt-br
https://source.android.com/setup/build-numbers
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Agora que o ambiente está preparado, nosso próximo passo é 
aprender a criar aplicações para dispositivos móveis com o sistema 
operacional Android Studio. Na próxima seção, criaremos nosso 
primeiro projeto.

Pesquise mais

Assista ao vídeo disponível em: <https://www.youtube.com/
watch?v=3iacZE1wY9s>. Acesso em: 5 fev. 2018, e veja com 
detalhes como é feita a instalação dos recursos necessários para o 
funcionamento do Android Studio.

Sem medo de errar

Você está em uma importante fase do projeto para o Pub, 
pois já acertou os detalhes com os sócios, inclusive já possui o 
esboço das classes que deverão ser implementadas no sistema. 
Porém, antes de efetivamente programar, você deve preparar 
a documentação do projeto conforme solicitado, a saber, a 
descrição de algumas características da IDE oficial e do arquivo 
AndroidManifest.xml. 

Comece a documentação com informações sobre a versão 
da IDE que será utilizada no projeto. Em seguida deixe registrado 
como é feita a instalação, para isso os seguintes itens são 
necessários: (i) site oficial para download; (i) recomendações de 
espaço, memória RAM e processador para executar o ambiente 
de desenvolvimento; (iii) passo a passo para instalação, inclusive 
do emulador.

Terminada a primeira parte da documentação, passe a registrar 
o que é o arquivo de manifesto: o arquivo AndroidManifest.xml é 
considerado o coração do aplicativo Android, pois nele estarão 
todas as informações sobre a configuração do app.

Em seguida apresente uma figura de uma captura de tela de 
um projeto Android, destacando o arquivo em questão. Essa figura 
ajudará na apresentação de alguns recursos.



U4 - Aplicação da tecnologia nativa para desenvolvimento Android 165

Explique a localização do arquivo dentro da árvore de pastas 

que o Android Studio cria. Em seguida explique os comandos que 

aparecem na Figura 4.11.

A primeira linha indica a versão do xml que foi usada para gerar 

o código, além da codificação usada. Explique que o xml é uma 

linguagem de marcação (assim como o HTML) e também funciona 

através de tags.

Deixe claro que apenas duas tags são obrigatórias: <manifest> 

e <application> e que elas devem ocorrer somente uma vez, ao 

contrário das demais que podem aparecer 0 ou N vezes.

O próximo passo é explicar o que cada uma das tags obrigatórias 

faz. A primeira é o elemento raiz do arquivo AndroidManifest.xml, sua 

declaração é acompanhada de alguns atributos, sendo alguns deles:

(i)	� xmlns:android. Esse atributo define qual a namespace de 

trabalho do Android. Fazendo uma analogia, podemos comparar 

uma namespace com uma biblioteca de informações. O valor 

do atributo deve sempre ser “http://schemas.android.com/

apk/res/android”, caso uma configuração diferente seja feita, 

os comandos não serão reconhecidos.

Figura 4.11 | O arquivo AndroidManifest.xml

Fonte: elaborada pelo autor.
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(ii)	� package. Indica o pacote do seu projeto, esse nome 
serve como um identificador do seu projeto. Por exemplo, 
vários projetos podem implementar uma classe chamada 
“ConexaoBanco”, o que diferencia uma classe da outra será 
o nome do pacote do projeto.

(iii)	� android:versionCode. Esse atributo identifica qual a versão do 
seu projeto. Vamos supor que o usuário está usando a versão 
1.0 e você fez uma atualização para a versão 1.2. Assim que 
você altera o valor nesse parâmetro, o usuário do aplicativo 
recebe uma notificação que existe uma nova atualização.

(iv)	� android:versionName. Esse parâmetro é apenas uma 
identificação para o usuário.

Apenas explicados esses parâmetros, passe à apresentação da 
segunda tag obrigatória <application>. Primeiro explique que ela 
deve vir entre o início e o fim da tag <manifest>. Dentro dessa tag irão 
ficar todos os demais elementos do aplicativo, como, por exemplo, 
todas as activities que forem criadas. Observe que na figura 4.11 
existe apenas uma tag <activity> </activity> (abrindo e fechando), 
portanto o aplicativo foi desenvolvido usando apenas uma activity.

Agora complete sua apresentação, consultando os endereços:

•	 <https://developer.android.com/guide/topics/manifest/ 
manifest-intro.html?hl=pt-br> 

•	 <https://developer.android.com/guide/topics/manifest/ 
application-element.html?hl=pt-br> 

E descreva mais alguns atributos das tags <manifest> e 
<application>.

Avançando na prática

Conhecendo uma activity

Descrição da situação-problema

Um gerente de uma empresa de desenvolvimento de software, 
percebendo que o desenvolvimento de aplicativos para dispositivos 
móveis se tornou um dos mercados mais rentáveis na área de 
software, decidiu treinar sua equipe para desenvolver aplicativos 
para o sistema Android usando a IDE oficial. Ao iniciar o projeto, 
ele percebeu que apenas saber programar não era suficiente, pois 
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os aplicativos dessa área possuem uma arquitetura diferente. Ao 
procurar conhecer esse novo universo, constatou que os aplicativos 
são desenvolvidos baseados em activities e lhe contratou para fazer 
uma apresentação aos programadores sobre as características 
desse elemento. Portanto, prepare uma documentação apontando 
alguns dos principais pontos.

Resolução da situação-problema

Comece sua apresentação explicando o que é uma activity:

Figura 4.12 | Captura de tela – a) MainActivity.Java – b) activity_main.xml

a)

Activity é um componente de aplicativo que fornece 
uma tela com a qual os usuários podem interagir para 
fazer algo, como discar um número no telefone, tirar 
uma foto, enviar um e-mail ou ver um mapa. Cada 
atividade recebe uma janela que exibe a interface do 
usuário. Geralmente, a janela preenche a tela, mas pode 
ser menor que a tela e flutuar sobre outras janelas. 
(DEVELOPER, 2017, p. 1)

Em seguida, explique que uma atividade depende de dois 
arquivos: MainActivity.Java e activity_main.xml e explique o que 
cada um deles representa no projeto.

Em seguida, mostre uma captura de tela de cada arquivo, 
conforme Figura 4.12.
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Use as imagens para explicar a localização desses arquivos na 
árvore de pastas e explique que, dentro do arquivo MainActivity.Java, 
o método setContentView(R.layout.activity_main) é o responsável 
por fazer a ligação entre os dois arquivos.

1. O ambiente de desenvolvimento de um aplicativo para o sistema 

Android depende do Java Runtime Environment (JRE). Esse software atua 

como uma camada entre o hardware e a aplicação, fazendo a tradução do 

código escrito em Java para a linguagem que o hardware entende.

Sobre a instalação do Android Studio, escolha a opção correta.

a) Devemos instalar primeiro o Android Studio para, só depois, instalar a JRE.

b) Devemos instalar primeiro o JDK, depois o Android Studio e, por fim, a JRE.

c) Devemos instalar primeiro a JRE, depois o SDK e, por fim, o Android Studio.

d) Devemos instalar primeiro o JDK, depois a JRE e, por fim, o Android Studio.

e) Devemos instalar primeiro a JRE, depois o Android Studio e, por fim, o SDK.

2. Activity é um componente de aplicativo que permite que as 

funcionalidades sejam implementadas. “Aplicativos geralmente têm várias 

activities pouco vinculadas entre si. Normalmente, uma activity em um 

aplicativo é especificada como ‘principal’, que é a apresentada ao usuário 

ao iniciar o aplicativo pela primeira vez. Cada activity pode, então, iniciar 

outra atividade para executar diferentes ações.” (DEVELOPER, 2017, p. 1). 

b)

Fonte: elaborada pelo autor.

Faça valer a pena
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Considere as seguintes afirmações e a relação proposta entre elas.
I – Cada activity terá um arquivo com extensão Java (arquivo.Java) e um 
arquivo com extensão xml (arquivo.xml). Embora eles sejam dependentes, 
são implementados separadamente.

PORQUE

II – Dentro do arquivo com extensão Java programa-se o layout 
do aplicativo, enquanto no arquivo de extensão xml programa-se o 
comportamento da activity.
a) As afirmações I e II estão corretas e a segunda é uma justificativa válida 
da primeira.
b) A afirmação I está correta e a II está incorreta.
c) As afirmações I e II estão corretas, mas a segunda não é uma justificativa 
válida da primeira.
d) A afirmação I está incorreta e a II está correta.
e) As afirmações I e II estão incorretas. 

3. Os aplicativos construídos no Android Studio podem ser testados 
tanto em um smartphone conectado, como no Android Emulator. Essa 
ferramenta pode ser instalada pelo próprio ambiente de desenvolvimento 
e simula um dispositivo físico em execução. Com o emulador é possível 
desenvolver e testar aplicativos para o sistema Android sem usar um 
dispositivo de hardware. 

A respeito dos emuladores do sistema Android, escolha a alternativa 
correta.
a) Para cada versão do sistema operacional Android deve ser instalada uma 
imagem do sistema.
b) Para executar todas as versões do sistema Android é preciso instalar 
uma única imagem.
c) Para executar todas as versões do sistema Android é preciso instalar 
uma única imagem, porém a cada nova versão é preciso atualizar.
d) Ao escolher uma versão do sistema Android para simular no ambiente 
de desenvolvimento, as funcionalidades do aplicativo não irão funcionar 
nas versões anteriores. 
e) Ao escolher uma versão do sistema Android para simular no ambiente 
de desenvolvimento não é mais possível alterá-la. 
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Desenvolvimento de um aplicativo para Android

Seção 4.3

Diálogo aberto 

Caro aluno, chegamos à última seção do livro de tecnologias 
para web e para dispositivos móveis. Durante nosso percurso vários 
conceitos e tecnologias foram apresentadas trazendo a você a 
oportunidade de um diferencial no mercado.

Nessa última unidade já aprendemos um pouco sobre o mundo 
da programação orientada a objetos aplicados à linguagem Java. Já 
entendemos a função de três importantes arquivos que fazem parte 
da estrutura de aplicativo Android (MainActivity.java, activity_main.
xml e Manifesto). Já vimos os passos necessários para a instalação 
do ambiente de desenvolvimento Android Studio, portanto, agora é 
hora de desenvolver seu primeiro aplicativo.

Dando continuidade ao seu projeto para o Pub, você deverá 
apresentar em uma Activity uma prévia do menu de comidas do 
pub. Levando em consideração a inclusão social, os sócios do Pub 
lhe solicitaram implementar um recurso que ao toque na tela a 
opção ”clicada” seja falada pelo aplicativo, assim, deficientes visuais 
também poderão usufruir do menu.

Para que você possa desenvolver o menu, nesta seção iremos 
apresentar os recursos que permitem a inserção de textos e imagens 
no layout, além do recurso de voz para cliques na tela. 

Bons estudos!

Não pode faltar

Toda vez que um programador inicia em uma nova linguagem 
de programação, faz parte da superstição criar o programa ”hello 
world”, portanto, não vamos contrariar a superstição! Faremos o 
desenvolvimento desta seção por meio de um aplicativo, no qual 
utilizamos caixa de texto, imagem e som. Portanto, iniciamos um 
novo projeto clicando em File > New > Project. Ao dar o comando 
na primeira tela, você poderá escolher (Figura 4.13):
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(I)	� Nome do projeto (Application name): Será o nome da sua 
aplicação, para nosso aplicativo, digite: HelloApp.

(II)	� Domínio da companhia (Company domain): Utilize o 
domínio de sua empresa, para nosso aplicativo, digite: 
minha_empresa.com.

(III)	� Localização do projeto (Project location): Escolha um local 
para que seu projeto seja salvo.

(IV)	� Nome do pacote (Package name): Esse campo é utilizado 
para identificar seu aplicativo dentro da Google play. O 
nome do pacote escolhido será o nome do pacote java 
onde estarão seus códigos-fontes. Esse valor não deve 
ser alterado em futuras versões do seu aplicativo, senão 
o Google play não conseguirá reconhecer a atualização. 
Existe um valor já criado para esse campo, composto por 
uma combinação dos campos (I) e (II). Primeiro vem o 
domínio da empresa seguido pelo nome do aplicativo.

Figura 4.13 | Captura de tela de novo projeto

Fonte: elaborada pelo autor.
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O passo seguinte consiste em escolher para qual dispositivo será 
o aplicativo, bem como a API mínima do Android. Para nosso app, 
escolha a API 23 (Android 6.0 Marshmallow). A escolha por APIs 
mais antigas permite que seu app funcione em um número maior 
de aparelhos, por outro lado, a cada nova versão são implementadas 
funcionalidades que podem não estar disponíveis nas anteriores. 
Então, você deve ter em mente: número de aparelhos x novas 
funcionalidades.

O próximo passo consiste na escolha do tipo de activity. Para 
nosso app, vamos escolher uma activity em branco e manter seus 
nomes originais, ou seja, MainActivity e activity_main (Figura 4.14).

Figura 4.14 | Adicionando uma nova activity



U4 - Aplicação da tecnologia nativa para desenvolvimento Android 173

Ao criar o novo projeto, o ambiente abrirá com os arquivos da 
activity abertos, mas por padrão será exibido o MainActivity.java.

O ponto de partida do nosso aplicativo depende do layout, por 
isso vamos clicar no activity_main.xml e, com esse arquivo aberto, 
vamos acessar o menu View > Tool Windows > Preview. Nesse 
momento uma tela de pré-visualização é aberta com um texto no 
centro da tela, “Hello World!” (Figura 4.15). O texto é exibido através 
de um componente do layout chamado TextView. Da linha 9 a 17 
está o código necessário para a inserção e configuração da posição 
do texto na tela. Como queremos escrever o nosso próprio app, 
apague esse conteúdo.

Fonte: elaborada pelo autor.
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O comando android.support.constraint.ConstraintLayout, na 

linha 2, é utilizado para criar um layout em que a posição dos objetos 

seja feita de modo flexível (é bastante utilizado para criar layouts 

responsivos). Iremos alterar essa configuração no nosso projeto, de 

modo que o layout seja linear, com os elementos sendo alinhados 

verticalmente. Por isso vamos alterar o arquivo activity_main.xml 

para o código da Figura 4.16.

Figura 4.15 | Tela inicial de uma activity em branco

Localização do arquivo

Área de edição no modo texto

Java de pré-visualização

Fonte: elaborada pelo autor.

Figura 4.16 | Layout antes e depois da alteração

a) Usando ConstraintLayout 
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Mudamos na linha 2 para o layout linear, que pode resultar em um 
alinhamento vertical ou horizontal, por isso foi preciso especificar 
na linha 7 qual seria a orientação. Por fim, como a linguagem xml 
trabalha com tags, é preciso abrir e fechar, por isso também houve 
uma alteração na linha 11.

Agora iremos inserir nossa mensagem de boas-vindas, para isso 
vamos adicionar um componente TextView, digitando o código 
conforme Figura 4.17.

b) Usando LinearLayout

Alterado

Inserido

Alterado

Fonte: elaborada pelo autor.

Figura 4.17 | Adicionando um TextView ao layout

Fonte: elaborada pelo autor.
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Como é possível observar na Figura 4.17, usamos 7 parâmetros 
(linhas 10 a 16) para adicionar um único texto na tela do 
aplicativo, vamos entendê-los. Cada componente é inserido 
usando a tag correspondente. No caso de um texto, optamos 
por usar um <TextView/>. Dentro da tag devem vir especificados 
os parâmetros do componente. Dentre os parâmetros, dois 
são obrigatórios: layout_width e layout_height, o primeiro 
utilizado para especificar a largura e o segundo a altura do 
componente (DEVELOPER, 2017). Ao especificar a largura com 
o valor ”match_parent”, determinamos que seria do tamanho do 
componente que contém o texto, nesse caso, a própria tela. Ao 
especificar a altura com o valor ”wrap_content”, determinamos 
que a altura irá se adequar ao conteúdo.

Os demais atributos são opções, entretanto, é de extrema 

importância que você sempre identifique os componentes com 

um nome (SILVA, 2016), para isso usa-se o comando da linha 11, 

no qual, após a barra, você pode especificar qualquer nome para 

seu componente.

Faça você mesmo

Altere os valores dos atributos layout_width e layout_height e veja 
as alterações que ocorrem no seu layout.

No parâmetro text é digitado o texto que se pretende exibir 
na tela (linha 14). As linhas 15 e 16 são atributos apenas estéticos, 
formatamos o alinhamento do texto e o tamanho. Veja que usamos 
a unidade do tamanho em sp, isso significa “pixel independente de 
escala” e é a opção recomendada pela documentação oficial.

Assimile

O nome de identificação de um componente deve ser único, não 
pode conter espaços nem acento. É uma boa prática de programação 
escolher nomes significativos e combiná-los com o próprio nome 
do componente. No nosso exemplo usamos texto1TextView, assim 
qualquer programador ao ver uma referência a esse componente 
saberá que se trata de um TextView.
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Exemplificando

Existem diversos controles que podem ser adicionados ao layout, 
vejamos alguns deles:

i.	� EditText: Caixa de texto utilizada para entrada de dados. 
Exemplos:

<EditText

  android:id=”@+id/emailEditText”

  android:layout_width=”match_parent”

  android:layout_height=”wrap_content”

  android:inputType=”textEmailAddress” />

<EditText

  android:id=”@+id/foneEditText”

  android:layout_width=”match_parent”

  android:layout_height=”wrap_content”

  android:inputType=”phone” />

<EditText

  android:id=”@+id/senhaEditText”

  android:layout_width=”match_parent”

  android:layout_height=”wrap_content”

  android:inputType=”textPassword” />

ii.	� Button: Componente usado para criar botões com textos. 
Exemplo:

<Button

  android:id=”@+id/simButton”

  android:layout_width=”match_parent”

  android:layout_height=”wrap_content”

  android:text=”Sim” />

iii.	� CheckBox: Componente usado para criar opções de seleção. 
Exemplo:

<CheckBox

  android:id=”@+id/adicionalCheckBox”

  android:layout_width=”match_parent”

  android:layout_height=”wrap_content”

             android:text=”Adicional” />
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Agora vamos ver como inserir uma imagem na tela do aplicativo. 

O primeiro passo é copiar uma imagem do seu computador e 

colar na pasta app > res > drawable, isso pode ser feito tanto pelo 

ambiente do Android Studio quanto pelo Explorer, selecionando a 

pasta drawable no local que você escolheu para salvar seu projeto. 

Em seguida, no arquivo activity_main.xml, digite o código das linhas 

18 até 22 conforme Figura 4.18. 

Figura 4.18 | Inserindo uma imagem

Fonte: elaborada pelo autor.

O componente usado para adicionar imagens é o <ImageView/>,  

sendo necessário especificar seu tamanho com os atributos  

layout_width e layout_height, além de informar a fonte da imagem 

com o atributo src (abreviação de source). O atributo cropToPadding 

foi usado para que a figura fosse “cortada” para não ultrapassar os 

limites do seu preenchimento.

Reflita

Textos e imagens podem ser combinados para criar layouts 
sofisticados e atraentes para o usuário. Como as proporções entre 
esses dois componentes podem ser alteradas de modo que cada um 
ocupe metade da tela?

Existem outros atributos que podem ser usados para manipular 
as imagens, veja alguns deles:
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•	 android:adjustViewBounds: Esse atributo é booleano, ou seja, 
aceita como valor true ou false. Quando configurado como true, 
ele ajuda a manter a razão de aspecto da imagem, em outras 
palavras, a imagem não é deformada conforme tamanho da tela.

•	 android:baselineAlignBottom: Esse atributo também é 
booleano e, quando ligado, alinha a imagem de acordo com 
a borda inferior.

•	 android:maxHeight: Atributo usado para especificar a altura 
máxima da imagem, aceitando como unidade px (pixel), dp 
(densidade da imagem), sp (pixel sem escala), in (polegadas) e 
mm (milímetros).

•	 android:maxWidth: Atributo usado para especificar a largura 
máxima da imagem e aceitar as mesmas unidades do atributo 
anterior.

•	 contentDescription: Esse atributo está relacionado à questão 
da acessibilidade do aplicativo. Ele é utilizado para atribuir um 
texto para ser lido quando o usuário tocar na imagem (DEITEL; 
DEITEL; WALD, 2016). Para isso, o usuário tem que estar 
com o TalkBack ativado no seu dispositivo (Configurações > 
Acessibilidade > Talkback).

Para os componentes de texto, o TalkBack irá funcionar a partir do 
atributo text, por isso não é preciso especificar o contentDescription.

Para finalizar nosso livro, vamos ver uma maneira que facilita a 
criação de layouts no Android Studio. Até o momento, trabalhamos 
na criação do layout com comandos via linha de comando e, 
embora existam comandos que só podem ser adicionados dessa 
maneira, a inserção e disposição dos componentes pode ser feita 
usando o modo visual, ou como é mais comumente chamado 
“modo design”. Para acessar a ferramenta basta clicar na aba Design, 
localizada na parte inferior da janela, conforme mostra a Figura 4.19.

Pesquise mais

Caso ainda tenha dúvidas de como usar as imagens dentro 
do ambiente do Android Studio, assista ao vídeo e aproveite 
esse novo universo. Disponível em: <https://www.youtube.com/
watch?v=3E8Ic4lZiE4>. Acesso em: 14 fev. 2018.
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Os modos texto e design podem ser alterados a qualquer momento, 
clicando em suas respectivas abas. Ao trabalhar no modo design 
também é possível configurar atributos via interface gráfica, acessando 
a janela de atributos conforme mostram as Figuras 4.19 e 4.20.

Figura 4.19 | Editor de layout no modo Design

Fonte: elaborada pelo autor.

Figura 4.20 | Alterando atributos via interface gráfica

Fonte: elaborada pelo autor.

Aproveite os recursos e a facilidade do modo design e explore 
os componentes visuais do Android Studio. Com esta seção, demos 
alguns passos no caminho do desenvolvimento de aplicativos para 
dispositivos móveis, continue seus estudos nessa promissora área e 
tenha um grande diferencial no mercado de trabalho!
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Chegou o momento de entregar um protótipo da tela do aplicativo 
para os sócios do Pub. Você viu que uma tela está associada a uma 
activity, que, por sua vez, está associada a um arquivo de layout com 
extensão xml.

O primeiro passo para essa entrega é criar um projeto e não alterar 
o nome da activity padrão, portanto, criará a activity_main.xml.

O segundo passo é alterar a segunda linha do arquivo activity_
main.xml, apagando o android.support.constraint.ConstraintLayout 
e digitando ScrollView. Esse componente permitirá que a tela deslize 
para cima e para baixo, conforme a quantidade de itens.

O terceiro passo é inserir um LinearLayout dentro do ScrollView. 
Você pode fazer esse passo usando o modo design. Dentro do 
menu Layouts, escolha a opção LinearLayout(vertical) e arraste para 
dentro da tela do aplicativo. Veja na figura 4.21 o modo design e o 
modo texto da tela até o momento. 

Sem medo de errar

Figura 4.21 | Formatação inicial da tela
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Use sua criatividade e explore os componentes usando o modo 
Design. Arraste os componentes para a tela e não se esqueça de 
atribuir um id para cada um dos componentes usados. Explore a 
formatação dos componentes (fonte, cor, tamanho etc.).

Para as imagens, você deve adicionar o atributo 
contentDescription a fim de que os deficientes visuais também 
usufruam dos recursos do aplicativo. Na Figura 4.22 – a está uma 
ideia para o menu; e na Figura 4.22 – b, parte do código.

Fonte: elaborada pelo autor.

Figura 4.22 | Ideia para o menu do Pub

a)
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b)

< ? x m l  v e r s i o n = ” 1 . 0”  e n c o d i n g = ” u t f - 8 ” ? >  
< S c r o l l V i e w   
xm l n s:an dr o i d=”ht t p://schem as .an dr o i d.co m /ap k /r es /an dr o i d”  
    x m l n s :a p p =”ht t p ://s chem a s .a n dr o i d.co m /a p k /r es - a u t o ”  
    x m l n s :t o o l s = ” ht t p :// s che m a s .a n dr o i d.co m / t o o l s ”  
    a n d r o i d :l a y o u t _ w i d t h = ” m a t c h _ p a r e n t ”  
    a n d r o i d :l a y o u t _ h e i g h t = ” m a t c h _ p a r e n t ”  
    t o o l s :co n t ex t =”co m .m i n ha _ em p r es a .s p .M a i n A ct i v i t y ” >

    < L i n e a r L a y o u t  
        a n d r o i d :l a y o u t _ w i d t h = ” m a t c h _ p a r e n t ”  
        a n d r o i d :l a y o u t _ h e i g h t = ” w r a p _ c o n t e n t ”  
        a n d r o i d :o r i e n t a t i o n = ” v e r t i c a l ” >

        < T e x t V i e w  
            a n d r o i d :i d = ” @ + i d / m e n u T e x t V i e w ”  
            a n d r o i d :l a y o u t _ w i d t h = ” m a t c h _ p a r e n t ”  
            a n d r o i d :l a y o u t _ h e i g h t = ” w r a p _ c o n t e n t ”  
            a n d r o i d :t e x t = ” M E N U ”  
            a n d r o i d :t e x t A l i g n m e n t = ” c e n t e r ”  
            a n d r o i d :t e x t S i z e = ” 2 4 s p ”  
            a n d r o i d :t e x t C o l o r = ” #3 03 F 9 F ” / >

        < C h e c k B o x  
            a n d r o i d :i d = ” @ + i d / c h e c k b o x _ w a v e _ f r i e s ”  
            a n d r o i d :l a y o u t _ w i d t h = ” m a t c h _ p a r e n t ”  
            a n d r o i d :l a y o u t _ h e i g h t = ” w r a p _ c o n t e n t ”  
            a n d r o i d :t e x t = ” W a v e  F r i e s ”  
            a n d r o i d :t e x t C o l o r = ” #1 8 1 9 1 8 ”  
            a n d r o i d :t e x t S t y l e = ” b o l d ”  / >

        < T e x t V i e w  
            a n d r o i d :l a y o u t _ w i d t h = ” m a t c h _ p a r e n t ”  
            a n d r o i d :l a y o u t _ h e i g h t = ” w r a p _ c o n t e n t ”  
            a n d r o i d :t e x t = ” N o s s a  b a t a t a  f r i t a  o n d u l a d a ”  
            a n d r o i d :t e x t C o l o r = ” #5 f 6 3 6 0”  / >

        < T e x t V i e w  
            a n d r o i d :l a y o u t _ w i d t h = ” m a t c h _ p a r e n t ”  
            a n d r o i d :l a y o u t _ h e i g h t = ” w r a p _ c o n t e n t ”  
            a n d r o i d :t e x t = ” R $  3 1 , 00”  
            a n d r o i d :t e x t C o l o r = ” #3 2 9 3 3 f ”  / >

    < / L i n e a r L a y o u t >  
< / S c r o l l V i e w >

Fonte: elaborada pelo autor.

Complete o código para o menu e aproveite o conhecimento 
adquirido nesta seção, aprofunde-o pesquisando sobre os recursos 
do Android Studio.
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Trabalhando com eventos no Android Studio 

Descrição da situação-problema

O dono de uma pizzaria lhe procurou para criar um aplicativo para 
Android para que seus funcionários pudessem fechar a conta dos 
clientes, aplicando um desconto ao valor total da conta. O desconto 
concedido varia conforme o cartão de fidelidade do cliente, sendo 
classificados em bronze (desconto de 7%), prata (desconto 10%) e 
ouro (desconto de 15%). Portanto, quando for até a mesa do cliente, 
o funcionário deve verificar qual é o cartão fidelidade e digitar no 
aplicativo o valor da conta e o respectivo desconto. Em seguida, o 
aplicativo exibirá o valor que o cliente deve pagar.

Resolução da situação-problema

Iremos trabalhar novamente com o layout linear, portanto no 
arquivo activity_main.xml é preciso alterar a segunda linha. Monte o 
layout conforme a Figura 4.23. Os componentes utilizados foram: um 
EditText para digitar o valor da conta e outro para digitar o desconto. 
Além deles, um botão para calcular e um TextView para exibir o valor 
a ser pago. Outros TextView foram usados apenas como rótulos  
de informações.

Avançando na prática
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Na Figura 4.23 também estão trechos do código do arquivo 
activity_main.xml dos componentes que também serão utilizados no 
código-fonte java. Veja no código do botão, o parâmetro ”onClick” 
foi usado no botão para ligá-lo a um evento que será trabalhado no 
arquivo com extensão java.

Na primeira linha do arquivo de extensão java estará a referência 
ao pacote java, o nome dependerá do que você informou no 
momento da criação do projeto. Você precisará importar bibliotecas 
para que os componentes funcionem (linhas 2 até 7). Também 
será preciso criar variáveis especiais para cada componente do 
layout que será utilizado (linhas 9 até 12). Precisará ligar as variáveis 
especiais aos seus respectivos componentes no layout (linhas 17 até 
20). Por fim, criar o método que realiza o cálculo e exibe o resultado 
na tela (linhas 22 até 28).

Figura 4.23 | Layout e código para o aplicativo
<?xml version="1.0" encoding="utf-8"?>
<LinearLayout xmlns:android="http://schemas.android.com/apk/res/android"

xmlns:app="http://schemas.android.com/apk/res-auto"
xmlns:tools="http://schemas.android.com/tools"
android:layout_width="match_parent"
android:layout_height="match_parent"
android:orientation="vertical"
tools:context="com.minha_empresa.calc_desc.MainActivity">

<EditText
android:id="@+id/valorBrutoEditText"
android:layout_width="500px"
android:layout_height="wrap_content"
android:inputType="numberDecimal" />

<EditText
android:id="@+id/descontoEditText"
android:layout_width="500px"
android:layout_height="wrap_content"
android:inputType="numberDecimal" />

<Button
android:id="@+id/calcularButton"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:text="Calcular"
android:onClick=“calcularDesconto" />

<TextView
android:id="@+id/valorFinaltextView"
android:layout_width="match_parent"
android:layout_height="wrap_content"
android:textSize="24sp"
android:textColor="#228B22"/>

</LinearLayout>

1.
2.
3.
4.
5.
6.
7.
8.
9.
10.
11.
12.
13.
14.
15.
16.
17.
18.
19.
20.
21.
22.
23.
24.
25.
26.
27.
28.
29.
30.
31.
32.
33.
34.
35.
36.

Fonte: elaborada pelo autor.
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1     p a c k a g e  c o m . m i n h a _ e m p r e s a . c a l c _ d e s c ;

2   i m p o r t  a n dr o i d.s u p p o r t .v 7.a p p .A p p C o m p a t A ct i v i t y ;
3     i m p o r t  a n d r o i d . o s . B u n d l e ;
4     i m p o r t  a n d r o i d . v i e w . V i e w ;
5     i m p o r t  a n d r o i d . w i d g e t . E d i t T e x t ;
6     i m p o r t  a n d r o i d . w i d g e t . T e x t V i e w ;
7     i m p o r t  a n d r o i d . w i d g e t . B u t t o n ;

8   p u bl i c cl a s s  M a i n A ct i v i t y  ex t en ds  A p p C o m p a t A ct i v i t y  {

9 	 p r i v a t e  E d i t T e x t  m V a l o r B r u t o ;
1 0	 p r i v a t e  E d i t T e x t  m D e s c o n t o ;
1 1 	 p r i v a t e  T e x t V i e w  m V a l o r F i n a l ;
1 2 	 p r i v a t e  B u t t o n  m C a l c u l a r ;

1 3 	 @ O v e r r i d e
1 4 	 p r o t ect ed v o i d o n C r ea t e(B u n dl e s a v edI n s t a n ceS t a t e) {
1 5 		  s u p e r .o n C r e a t e ( s a v e dI n s t a n ce S t a t e ) ;
1 6 		  s e t C o n t e n t V i e w ( R .l a y o u t .activity_main) ;

1 7 		  m V a l o r B r u t o  =  
		      f i n d V i e w B y I d ( R . i d . valorBrutoEditText) ;
1 8 		  m D e s c o n t o  =   
    f i n d V i e w B y I d ( R . i d . descontoEditText) ;
1 9 		  m C a l c u l a r  =   
    f i n d V i e w B y I d ( R . i d . calcularButton) ;
2 0		  m V a l o r F i n a l  =   
		      f i n d V i e w B y I d ( R . i d . valorFinaltextView) ;
2 1 	 }

2 2 	 p u bl i c v o i d  ca l c u l a r D e s co n t o ( V i e w  v i e w ) {
2 3 		  f l o a t  v a l o r F i n a l ;
2 4 		  f l o a t  v a l o r B r u t o  =   
		 �  F l o a t .parseFloat( m V a l o r B r u t o .ge t T e x t ( ) .

t o S t r i n g ( ) ) ;
2 5 		  f l o a t  d e s c o n t o  =   
		 �  F l o a t .p a r s eF l o a t (m D es co n t o .get T ex t ().

t o S t r i n g ( ) ) ;
2 6 		  v a l o r F i n a l  =   
		      v a l o r B r u t o  -  ( v a l o r B r u t o  *   
      ( d e s c o n t o / 1 00) ) ;
27    m V a l o r F i n a l .s et T ex t (S t r i n g.v a l u eO f(v a l o r F i n a l ));
2 8 	 }
2 9     }

Execute seu projeto em um emulador ou então conectando um 
celular com sistema Android ao computador.
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1. Um aplicativo Android é composto por atividades e para cada activity 
é gerado um arquivo xml e outro java. No arquivo xml é feita toda a 
configuração do layout e pode ser trabalhada tanto no modo texto como 
no gráfico. Ambos os modos possuem vantagens e desvantagens, cabe ao 
programador se apropriar de ambos os conhecimentos.

Considere as seguintes afirmações e a relação proposta entre elas.
I – Configurar um layout como LinearLayout é a melhor opção para os 
aplicativos.

PORQUE

II – Com essa opção os elementos são alinhados sequencialmente 
com uma orientação horizontal ou vertical, dependendo da escolha do 
programador.

a) As afirmações I e II estão corretas e a segunda é uma justificativa válida 
da primeira.
b) A afirmação I está correta e a II está incorreta.
c) As afirmações I e II estão corretas, mas a segunda não é uma justificativa 
válida da primeira.
d) A afirmação I está incorreta e a II está correta.
e) As afirmações I e II estão incorretas. 

2. “Para quem está chegando de mundos um ‘pouco’ mais limitados em 
relação à interface gráfica para dispositivos móveis como, por exemplo, 
o cenário encontrado no desenvolvimento de aplicativos para aparelhos 
celulares mais antigos, a plataforma Android é um verdadeiro paraíso. 
Com dezenas de componentes visuais sofisticados, com efeitos e muitas 
características disponíveis para serem personalizadas, a plataforma 
Android está se tornando uma referência na quantidade e na qualidade 
dos componentes visuais existentes.” (DEVMEDIA, 2017, p. 1) 

A respeito dos componentes visuais de texto que podem ser usados no 
aplicativo, escolha a opção correta.

a) Um TextView só pode ser usado para exibir um texto.
b) Um TextView pode ser usado tanto para exibir um texto como para o 
usuário digitar valores.
c) Um EditText só pode ser usado para exibir um texto.
d) Um EditText pode ser usado tanto para exibir um texto como para o 
usuário digitar valores.
e) O atributo inputType do componente EditText é usado para especificar 
o tamanho do campo. 

Faça valer a pena
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3. Layouts são compostos por diversos elementos gráficos, textos, 
imagens, caixas de seleção etc. Considere as afirmações a respeito de 
alguns componentes.
I – O atributo contentDescription é utilizado em imagens para adicionar 
um texto que será lido caso o usuário tenha o talkback ativado em seu 
celular.
II – O atributo id, utilizado para identificar os componentes, é um dos 
atributos obrigatórios. 
III – Um componente EditText com o atributo inputType=“numberDecimal” 
não aceita que o usuário digite valores diferentes do numérico. 

Considerando as afirmações a respeito dos componentes visuais, escolha 
a opção correta.

a) Apenas a alternativa I está correta.
b) Apenas a alternativa III está correta.
c) Todas as alternativas estão corretas.
d) Apenas as alternativas I e II estão corretas.
e) Apenas as alternativas I e III estão corretas. 
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